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What is Workspace? 
 Workspace is a program that connects a computer to an Interwrite interactive whiteboard, 

panel or wireless pad. 

 The program includes tools for writing and drawing during a presentation. 

 Teachers can use Workspace to create and conduct interactive lessons. 
 

 

 

 

Getting Started 
 Before using the Interwrite Pad, Interwrite Mobi, or the interactive pen for the first time, they 

should be charged for about 12 hours. 

 Make sure Pad and Pen(s) are charged before connecting to the computer. 

Charging the Interwrite Pad 
 Plug the AC adapter into the top of the pad and then into a power source. 

Note: The Interwrite Pad can be used while it is charging. 

 Secure the pen in the recharging holder.  

 Two orange lights will appear indicating the Pad’s battery and pen. 

 Lights turn off once the Pad and/or pen are fully charged. 

Charging the Interwrite Mobi 
 When the Mobi battery is low, the Battery Status icon will display as an empty battery.  

 Place the Interactive Pen in the Pen slot. 

 Connect the Mini USB Cable to the Mini USB port at the top of the Mobi and 

then into a USB port on the computer. Note: The Interwrite Mobi can be used 

while it is charging.  

 When fully charged the Battery Status icon will display a full battery.  

 Unplug the charging cable from the Mobi. 

Charging the Interactive Pens 
 Plug in the AC adapter for the Interwrite Board.  

 Make sure the charging pen holder is plugged into the control box on the board. 

 Secure the pens into the holder. 

 Green lights will appear for each pen. 

 Lights turn off once the pens are fully charged. 

 Note: extra pen tips can be stored on the charging pen holder. 

Interactive Panel Interactive Pad Interactive Mobi Interactive Whiteboard 
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Connecting the Interwrite Panel 
 Plug in the AC adapter for the Panel. 

 Connect the USB cable and the VGA cable to the computer. 

Installation of Software 
 Install Interwrite Workspace using the CD that came with the interactive Panel, Board or Pad. 

 Workspace may also be downloaded from 

http://www.einstruction.com/support_downloads/downloads.html. 

 For wireless pads and wireless whiteboards: 

o Plug in the USB Bluetooth Receiver. 

o A Found New Hardware wizard will appear indicating a new device has been detected. 

o After a minute the wizard will indicate that the drivers are found and the device is ready 

to use. 

 Note: Take notice of the USB port in which the Bluetooth Receiver is installed. If the receiver is 

plugged into a different USB port another time, the Hardware Wizard will reappear indicating a 

new device has been detected again as noted in the steps above. 

 Once the software and Bluetooth Receiver have been 

installed, restart the computer. Two new icons will 

display in the System Tool tray on the bottom right of 

the screen.  

Setup and Device Manager 

Connecting Bluetooth Devices 
The Interwrite Board and the Interwrite Pad connect to the computer 

wirelessly using a USB Bluetooth connection. The Interwrite Panel 

connects directly through a USB cable. Note: If there is not an internal 

Bluetooth in the computer, make sure that the Bluetooth “dongle” is 

connected and installed on the computer. 

 Turn on the Board or Pad. A series of beeps will sound. For the 

panel, make sure the power is turned on.  

 Click on the eInstruction Tools  icon.  

 Select eInstruction Device Manager. 

 Close the Device Manager First Look Window after reading the 

top section to find the Bluetooth address. Note: Uncheck the box at the bottom of this window 

to not show the First Look Window at start up. 

 Click on the green plus button  to add a Bluetooth 

eInstruction Tools Icon 
Bluetooth Icon 



Educational Technology Center  

Davis School District, Farmington, Utah 84025 Page 4 Revised 8/26/2009 

device and/or the panel. 

 Type in the last four digit or letter combination of the 

Bluetooth address and click Connect. 

 Or click on Scan for Devices. Wait for the scan to finish. 

 Once the scan finds the device, select the device and click 

Connect. 

 The device manager will connect the device and then 

display the device icon in the eInstruction Device Manager window. 

 The pad or board will beep when connected.  

Connecting RF Devices 
The Interwrite Mobi and the Interwrite DualBoard connect to the computer wirelessly using an RF 

(Radio Frequency) communication module. 

 Plug the RF Receiver into a USB port on the computer. The computer will automatically detect 

the USB device and install the new hardware for use. 

 A blue LED light on the RF Receiver will light up when it is plugged in.  

 Turn on the Mobi or DualBoard. 

 Press the lighted Activation button on the RF Receiver. The blue LED light will start blinking. 

 Turn over the Mobi and press the blue button next to 

the battery case to activate the RF signal. Note: Up to 

two minutes is allowed to press the Activation button on 

the Mobi or DualBoard. 

 When paired, the blue LED light on the RF Receiver will 

stop blinking and remain solid blue until either the 

computer or the Mobi is turned off. 

 The Mobi or DualBoard device icon will display in the 

eInstruction Device Manager window and will 

autoconnect from this point on.  

KWIK Screen on the Mobi 
The Mobi KWIK Screen displays icons associated with the Mobi status. 

Icon Name Description 

 Mouse Mode Pen used as a mouse 

 Paired Paired with computer 

 USB Connected via USB cable 

 In Proximity Pen within proximity, detected by Mobi 

 In Menu KWIK screen in use, out of proximity 

 Battery Status Battery life and charge shown 

 Pen Charge Pen charge shown 
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Naming Devices 
 Select the device icon in the Device Manager window. 

 Click on Options and select Properties or click on the 

wrench  Properties button. 

 Select the General tab at the top of the window.  

 Type a device name in the Name text field. 

 Note: This is also where the battery status of the 

Interwrite pad can be checked. 

Calibrating Devices 
 Note: Only Whiteboards and Panels require calibration. 

 Select the device from the Device Manager window. 

 Click the Options button. 

 Select Calibrate. 

 A blue screen will appear with instructions. 

 Click on each cross-hair target as it appears on the screen. 

 The blue screen will disappear after last cross-hair target is clicked. 

 The Interactive Whiteboard also features a shortcut softkey on the side of the board for quick 

calibration. 

The Interactive Pen 
 Interwrite Boards, Panels, and Pads require an interactive pen. 

 Tap on the board, pad or panel with the pen tip to left 

click.  

 Hold pen just above the surface of the board, pad or panel 

and press the upper part of the button towards the top of 

the pen to right click. 

 Hold pen just above the surface of the board, pad or panel 

and press the lower part of the button towards the tip of 

the pen to double click. 

 Recharge the pen regularly. 

o Place the pen firmly in the recharging holder. 

o A light will indicate if the pen is charging properly. Note: When charging the Mobi pen, a 

pen and a battery icon will appear on the KWIK screen indicating the pen is charging. 

o Remember to return the pen to the recharging holder when not in use. 

  

Left Click 

Double Left Click 

Right Click 
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Interactive Mode 
 Click on the eInstruction Tools icon in the tool tray and select Workspace. 

 Interactive mode may also be accessed through the Start menu → All Programs → eInstruction 

→ Interwrite Workspace → Interactive Mode. 

 A toolbar will appear near the right hand side of the desktop. 

 The toolbar will go transparent after non-use. 

The Basic Toolbar 
 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Moving the Toolbar 
 Position the mouse pointer 

at the top of the toolbar 

near the Interwrite icon

. 

 Click and drag the toolbar 

to new location. 

Resizing the Toolbar 
 Position the mouse pointer 

on the edge of the Toolbar 

until a double-headed 

arrow appears. 

 Click and drag the double-

headed arrow to change 

the size and layout of the 

Toolbar. 

Toolbar Settings 
 Click on the Workspace 

Menu button  and 

select Preferences. 

 Click on the Toolbar 

Settings tab. 

 Under the section Shape 

Files, select a desired 

shape. A preview will 

display. 

 Under the section Toolbar 

Button Size in Pixels, select 

the desired size. 

 Click Ok. 

Minimize Toolbar 

Create Grid Page 

Clear 

Text 

Shapes 

Highlighter 

Selection Tool 

Mouse Mode 

Exit 

Toolbox 

Page Sorter 

Previous Page 

Workspace Menu 

Gallery 

Create Blank Page 

Undo 

Line 

Eraser 

Pen 

Lesson Mode 

Student Response 

System 

Save 

Next Page 
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Creating Pages 
Tool Name Description 

 
Blank Page Tool 

Click to create blank pages for lessons, notes, etc. 
To change the color of the page:  

 Choose the selection tool .  

 Click on the white box located on the 
property toolbar at the bottom of the 
screen.  

 Choose color. 

 Click Ok. 

 Note: The color will only change on 
this page. 

 
Grid Page Tool 

Click to create grid pages for lessons, notes, etc. 
To change a blank page to a grid page: 

 Click on the grid page tool located on the properties 
toolbar at the bottom of the screen. 

 

Blank Pages 
 To customize the page color: 

o Click on the Workspace Menu button  and select Preferences. 

o Click on New Page Setup tab at the 

top of the window. 

o Click on the Change Background 

Color button.  

o Select a new color as the default 

page color. 

o Click Ok. 

o Click on the Create Blank Page 

button  on the toolbar to create 

a new page in Workspace. 

Grid Pages 
 To customize the grid lines and colors: 

o Click on the Workspace Menu 

button  and select 

Preferences. 

o Click on the New Page Setup tab at 

the top of the window. 

o Make desired changes in the Grid 
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Page area.  

o Click on the Change Background Color button. 

o Select a new color as the default grid page color. 

o Select other desired changes such as vertical lines, center grid, title box, line color, line 

spacing, etc. 

o Click Ok. 

o Click on the Create Grid Page button  on the toolbar to create a new grid page in 

Workspace. 

Main Tools and Descriptions 

Properties Bar 

 When selecting any tool a Properties Bar will appear at the bottom of the screen with options 

specific to that tool. 

 

Annotation Tools 
Tool Name Description 

 
Pen Tool 

Click to write and/or make notes on the screen or Workspace 
page. This tool gives the option to change pen color, width, 
transparency, style, etc. by using the property bar.  

 

 
Highlighter 

Click to highlight any text or image on the screen or Workspace 
page. This tool gives the option to change highlighter color, 
shape, width, transparency, etc. by using the property bar. 
 
 

 
Shapes Tool 

Click to create basic shapes. 
To change to a different shape: 

 Click on the shape in the property bar and select 
desired shape.  

 Use options on the property bar to modify the shape 
outline, width, outline style, transparency, shape style, 
color fill, etc. 

 Click and drag to draw the shape on the screen or 
Workspace page. 

Change Line Transparency Preview Change Line Width 

Change to Preset Pen Color 

Custom Pen Color 
Change Line Style 

Change Line End 
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Tool Name Description 

 
Line Tool 

Click and drag to create lines on the 
screen or Workspace page.  

Note: Use the selection tool  to 
select the line and then use the four-
headed arrows to change the angle or 
length of the line. Use the eraser tool to 
cut the line in parts maintaining the 
endpoints chosen for the original line. 

 
Text Tool 

Click on the text tool then click on the 
page where the text will be placed and 
type text into the box that appears.  

Click on the Duplicate Text button  to create a new copy of 
the text box with the same text. 

Click on the Split Text button  to separate multiple words 
into their own individual text boxes. 

 

Editing Tools 
Tool Name Description 

 
Eraser 

Click to erase annotations. Note: the Eraser tool only erases 
lines drawn with the Pen, Highlighter, and Line tools. It does 
not work with Shapes, Imported images, or Sims. 
Change eraser size by clicking and dragging the slider in the 

Eraser property bar.  
Use pad Pen to erase by holding the double click button when 
the Pen tool is in use. 

 
Undo 

Click to Undo or remove the most recent change to a 
Workspace page. Keep clicking to continue removing changes 
until there are no more changes to remove. 

 
Clear 

Click to remove items on a Workspace page. With the 

Selection tool , select any Item on a page and then click the 
Clear tool to delete the selected item. If no selection is made 
the Clear tool will clear all items from a page. 
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Tool Name Description 

 
Selection Tool 

Click to select items on a Workspace page. This tool gives the 
option to redo, undo, cut, copy, paste, select all, arrange, 
rotate, group, export, move to background, move to gallery, 
etc., by using the property bar.  

Use the selection tool to click on text, lines, shapes or images 
on a Workspace page. A bounding box will appear around the 
item selected. Options for that item will appear in the 
property bar at the bottom of the screen. Select desired 
options to change previous options. To move, resize, or rotate 
an item: 

 Move: Select an item to get the 
four-headed arrow. Drag item to 
new location.  

 Resize: Select an item. Click on 

the resize icon  at the lower 
right corner of the selection bounding box and drag 
box to new size. 

 Rotate: Select an item. Click on the rotate icon  at 
the top center of the selection bounding box and drag 
box to new angle. 

To lock or easily copy multiple copies of an item: 

 Lock: Select an item. Click on the Lock Tool . This 
wil display a lock icon on the item when it is selected. 

 Copier: Select an item. Click on the Copier Tool . 
Click and drag as many times as desired to get copies 
of the item. This will diplay a copier icon on the item 
when it is selected. 

 

Selection Tool Properties 

  
Tool Name Description 

 
Undo/Redo 

Click to undo or redo the most recent performed task. 
Continue to click for undoing or redoing more tasks. 

 
Cut Click to remove a selected item. 

 
Copy Click to copy a selected item. 

 
Paste Click to paste a cut or copied item onto a Workspace page. 
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Select All Click to select all items on a Workspace page. 

 

Order Selected 
Entities 

Click to change the position of a selected item to be in front of 
or in back of other items on the Workspace page. 

 

Rotate Selected 
Entities 

Click to rotate a selected item 90°, 180°, or flip item 
horizontally or vertically. 

 
Group 

Click to group separate selected items together to create one 
item. 

 
Ungroup 

Click to ungroup a previously grouped item to separate the 
items. 

 
Move to Background 

Click to permanently “glue” an item to the background of a 
Workspace page. 

 
Export Entities 

Click to export a selected item and convert it into an image 
file. 

 
Add files to Gallery Click to add a selected item or the entire page to the Gallery. 

Extending a Page and Panning 

 By clicking on either the downward extend button  or the right side extend button  this 

will extend the default blank page space onto the Workspace page. 

 Click on the Pan Tool  located at the bottom right corner of the screen and then click and 

drag on the Workspace page to move in any direction across a page that is larger than the 

current screen size. 

 The cursor will change to a hand.  

 Click on the pan tool again to turn off the pan option. 

Layers Toolbar 
By default, all items are organized in a single layer. To add layers: 

 Locate the Layers Toolbar  at the bottom left corner of the Workspace 
page.  

 To view the layers click on the maximize layers button . 

 Click the Add Layer button . 

 The Layer Toolbar has additional options such as moving layers 
up/down, selecting layers, showing/hiding layers, editinig layers, and 
deleting layers. 
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File Management Tools 
Tool Name Description 

 
Workspace Menu 

Click to access files, edit, print, change preferences, etc. 
To Save a File: 

 Click on the Menu 
button. 

 Select File.  

 Click Save As. 

 Type in a file name. 

 Click Ok. 
To Open a File: 

 Double click on the file. 

 Or click on the Menu 
button. 

 Select File. 

 Click Open.  

 Choose the file to be opened and click OK. 
To Export a File: 

 Click on the Menu 
button. 

 Select File. 

 Click Export.  

 Choose the format 
desired for export, the 
location for export, and the page(s) desired to export. 

 Click Export when done. 
To Print a File: 

 Click on the Menu 
button. 

 Select File. 

 Click Print.  

 Choose the options for the printer and click Print. 

 
Previous/Next Page 

Click to navigate backward or forward through already created 
pages in Workspace.  
Note: There is an alternative method to navigate pages in the 
lower right-hand corner of the screen. This method also 
includes the current page number and 
page count.  
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Tool Name Description 

 
Page Sorter 

Click to view all Workspace pages. 
For viewing size, click on the Page Sorter 

Menu button . Select Zoom and 
choose desired page size for Page Sorter 
window.  
To reorder/rearrange pages: 

 Highlight one or multiple pages 
by clicking on the page. 

 Drag and Drop to new position. 

 Exit the page sorter window 
when done. 

To delete pages: 

 Highlight one or 
multiple pages 
by clicking on the 
page.  

 Click the delete 

button  at 
the top of the 
Page Sorter window.  

 Note: Pressing the delete key on the keyboard will also 
delete selected pages when in the Page Sorter 
window. 

 
Save 

To Save a file: 

 Click on the Save tool. 

 Select location for the file to be saved. 

 Type a name for the file. 

 Click Ok. 

 
Toolbox Click to display a submenu of additional tools. (See page 18) 

 
Exit Click to Exit Workspace completely. 

 

Presentation Tools 
Tool Name Description 

 
Minimize Toolbar 

Click to minimize the Workspace toolbar so it does not block 
any other program or application. 

 
Mouse Mode 

Click to return regular functionality to the computer and allow 
pen to work like a mouse. 
Use any drawing tool (pen, shape, text, etc.) to instantly record 
a screen capture and return to Workspace. 
Click on the navigation arrows to return to a Workspace page. 
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Tool Name Description 

 
Lesson Mode 

Click to return to the default Workspace Toolbar in Interactive 
Mode. 

 

Student Response 
System 

Click to use Workspace Interactive Mode with Interwrite 
products such as PRS transmitters, Response software, etc. 

Copy and Paste 
 Select the graphic. 

 Right click on top of the picture. 

 Select copy. 

 Go back to the workspace lesson. 

 Paste the graphic on your lesson by clicking the paste button  or clicking on Ctrl+V at the 

same time. 

The Gallery 
Tool Name Description 

 
Gallery tool 

Click to access resources using 
Interwrite Gallery window. 

Categories 
 Select different categories to view pre-existing files organized by subject. 

 Select subject and sub-categories. 

 Click on resource in the lower window. 

 Drag resource to existing page in Workspace. 

Resources from Gallery 

 

 

Image Type Description 

 

Background: The folded corner indicates this image takes 
the whole screen and it is used as a background on a 
Workspace page. 

 

Image: A single image can be resized, moved, or rotated 
on a Workspace page by using the selection tool and then 
clicking and dragging the item. 

 

Sims: The  symbol indicates that this is an interactive 
program made in Flash that includes animation, sound, or 
games. These Sims are provided free with Interwrite 
Workspace.  
Note: Many of the Sims do not include instructions and 
require some playing in order to learn how to use them. 
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Searching for Resources 
 Type a keyword in the text field at the top of the Gallery window. 

 Click on the Keyword Search button . 

 Scroll through the resources in the lower window to find search matches. 

Sample Lessons 

 To view sample lessons, select Lessons in the upper Gallery window. 

 Online Lessons: 

o Click on the Online Lessons category to go to the eInstruction website online lessons 

and resources available for download 

(http://www.einstruction.com/support_downloads/content/workspacelesson/index.html). 

o Search for lessons by viewing all, browsing by state curriculum standard, or by keyword. 

o Click on desired lesson. 

o Click on the Download button. 

o Save download .gwb file to My Documents/Interwrite Workspace/ Lessons. 

o Lessons can be saved, modified, and re-used with changes. 

 Sample Lessons: 

o Click on Sample Lessons to view, open, and edit sample lesson files for Workspace. 

o These files are also found in C:\Program Files\Interwrite Learning\Interwrite 

Content\Lessons. 

 Video Tutorials: 

o To view video tutorials, select Video Tutorials to go to the eInstruction website online 

tutorials (http://www.einstruction.com/support_downloads/training.html). 

o These tutorials go over basics of using tools in Workspace. 

Add Media from File 

 Click on the Gallery button . 

 Click on the Gallery Menu button . 

 Select Add a File to Gallery. 

 Click the Browse button to find media resource. 

o Images: BMP, JPEG, GIF, EMF, WMF, TIFF, PNG, ICO 

o Sound: WAV, MP2, MP3, MPA, MPEG, SND, WMA 

o Video: AVI, WMV, MOV, MPEG 

 Click Ok. 

 Select or type in a category. 

 Type in a Name to be displayed. 

 Type in any relevant Keywords describing the resource. 

 Click Save and Exit or Save and Add Another. 
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Add Media from Selection 

 Click the Selection tool  . 

 Click to select an item on the current Workspace page. 

 Click on the Add Files to Gallery button  on the 

Property bar.  

 Select Add Selection to Gallery. 

 Select or type in a category. 

 Type in a File Name. (Note: Choose category before 

naming the file.) Remember to add the file extension  

.png to the file name. 

 Type in a Name to be Displayed. 

 Type in any relevant Keywords describing the resource. 

 Click Save and Exit. 

Remove Media from Gallery 
 Right click on the desired resource to be removed in the lower Gallery window. 

 Select Remove from Gallery. 

 Note: if Delete Permanently is selected, this action cannot be undone and the resource will be 

removed completely from the Gallery database. 

Multi-User 
 With the DualBoard interactive whiteboard two people can write on the 

board at the same time. 

 With multiple Pads or Mobis more than one can write on the screen at a 

time. 

 Using a Bluetooth dongle up to seven devices may be connected to the computer at once. 

 Using the Multi-User option in the software and RF receivers with the Mobi or DualBoard up to 9 

devices can be writing on the screen at once. 

Setting Up Multi-User 

 First connect all devices to be used in the Device Manager 

window. 

 Open Interactive Mode and create a blank page. 

 Click on the Multi-User icon in the bottom right 

corner of the screen. Note: The connected devices 

will be displayed.  

 Select Multi-User Page Setup. 

 Select the page layout desired. 
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 Select each device and drag it to the area desired.  

 Click Ok. 

 Each device in the page layout will have its own simplified toolbar. 

Set Presenter 
 Open the Device Manager window. 

 Select the device desired to be the master pad. 

 Click on the Options menu.  

 Select Set Presenter. 

 Click Ok. 

Locking Pads 
 Open the Device Manager window. 

 Select the device to be locked. 

 Click on the Lock Pad icon . 

 To unlock, select the device and click on the Unlock Pad icon . 

 A lock all/unlock all pads button  is also located in the Toolbox  on the 

Workspace Toolbar. 

Creating New Lessons 

 Click on the Workspace Menu icon .  

 Select File → New. Note: Launching Workspace software if closed will also begin a new file. 

 Add a new blank page  or a new grid page  from the 

toolbar. 

 Add text to a page using the Text tool . 

o Type text into text box.  

o Copy and paste text from existing documents. 

o Resize text box to desired size. 

 Add images and sound files from the Gallery . 

 Add basic shapes to a page using the Shapes tool . 

 Use the Selection tool  and click on any item on the page to move, 

resize or rotate. 

 To make copies of shapes, text, etc.:  

o Select the item. 

o Select the Copier tool . 
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 Navigate lesson pages by using the Previous Page and Next Page tools . 

 Find pages, reorganize or delete pages using the Page Sorter tool .  

 Click on Workspace Menu → File → Save. 

The Toolbox 

 Click on the Toolbox tool  on the toolbar.  

 A sub-menu will appear displaying additional tools available in Workspace.  

 Below are some of the additional tools with descriptions of the tools that appear in the Toolbox. 

Tool Name Description 

 
Annotate over Desktop 

Click to use like Mouse Mode, however the desktop is underneath and can be 
accessed for use without annotations disappearing. 
Use the selection tool for mouse function. 
Once another tool is selected, a prompt will ask to save or discard the 
annotations as a page. 

 
Office Mode Click to integrate tool use with Microsoft Office Programs. 

 
Exam View Opens the exam view file. 

 
Ruler Use to show measurement between two points interactively. 

 
Triangle 

Use to demonstrate how to measure interactively. Select from left or right 

facing triangles. 

 
Protractor 

Use to demonstrate how to use angle measurement interactively. Select from 

180° or 360° protractors. 

 
Compass 

Use to draw circles, arcs, and measure distances interactively. Use the selection 

tool to exit. 

 
Curtain 

Toggles virtual curtain to partially cover screen in Workspace. The curtain 

properties bar has resize handles, gives maximize and transparency options, and 

closes the tool. 

 
Capture Captures items, windows, or screens from computer screen. 

 
Record and Playback Opens control to record and display a Workspace lesson. 

 
New Page Setup Changes default page settings for new blank and grid pages. 

 
Stamper Adds quick shape or image with each mouse click. 

 
Fill Tool Adds quick fill color to image or page with each mouse click. 

 
Freehand Text Converts text written with the interactive pen into text format. 

 
Freehand Shape Converts shape drawn with interactive pen into basic shape. 

 
Multicolor Pen Draws two-color lines. 
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Tool Name Description 

 
Picture Pen Draws quick shapes or images in a line or pattern as drawn. 

 
Create Image Page Adds page with background image, such as music staffs and graphs. 

 
Spotlight 

Masks workspace and only displays area inside “spotlight” shape.  

 Click on the Spotlight icon.  

 Use the cursor to drag the Spotlight. 

 When done, click on the Close Spotlight button at the bottom of the 
screen. 

The spotlight properties bar has resize handles, gives a menu option for shapes, 
transparency and window color, and closes the tool. 

 
Link History 

Link History is an account of the GWB links. It maintains a record of back links, 

allowing a click to follow the history of the links and go back to any one of the 

links during the current session. This tool is available only when a presentation 

file is open in the Annotation Window and a GWB link has been executed. 

 
Zoom Enlarges a portion of a Workspace page for viewing details. 

 
Create Duplicate Page Duplicates current page into new page. 

 
Create Calendar Page Selects date and layout for new calendar page. 

 
Create Gradient Page Adds a gradient page to the presentation file. 

 
Flash Player Imports an interactive Flash (.swf) file into Workspace. 

 
Audio File Imports an audio file and virtual player into Workspace. 

 
Video File Imports a video file and virtual player into Workspace. 

 
Export PDF File Exports Workspace lesson to Portable Document Format. 

 
Email PDF File Exports Workspace lesson to PDF and opens default email client. 

 
Pan Page Moves a page up, down, left and right when larger than viewable screen. 

 
Onscreen Keyboard Opens virtual keyboard on screen. 

 
Lock Pads Locks all wireless pads connected to Workspace except the Master pad. 

 
Start Internet Browser Opens default Web browser. 

 
Page Up Moves to page above. 

 
Page Down Moves to page below. 

 
Insert Media Imports audio, video, or image files into Workspace. 
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Tool Name Description 

 
Device Manager Opens window to connect or disconnect whiteboard, panel or wireless pads. 

 
Redo Reapplies a change that was recently “undone.” 

 
Preferences Opens Workspace preferences window. 

 
Text Recognition Opens window for freehand text recognition. 

 
Timer 

Puts a timer on the screen for timed activities. 

 Click on the Timer icon . 

 Set the timer to timer or stopwatch. 

 Click on the Set Timer drop-down arrow to select the 
length of time. 

 Click on Start to begin. 

 


